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1. System configuration 

The system configuration of TOP-R and “Corporation Con Series (Modbus)” is as follows: 

 

Series CPU Link I/F 
Communication 

method 

Communication 

setting 
Cable 

IAI 

Corporation 

A,P,SCON Series(MODBUS) 

ERC Series(MODBUS) 

RS–232C 

3. TOP-R 

Communication 

setting 

5.1. Cable table 1 

RS–485 

RS-422 

3. TOP-R 

Communication 

setting 

5.2. Cable table 2 

 

■ Connectable configuration 

 

ㆍ1:1 (one TOP-R and one external device) connection – configuration which is possible in RS232C/422/485 communication. 

 

 

ㆍ1:N (one TOP and multiple external devices) connection – configuration which is possible in RS422/485 communication. 
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2. External device selection 

■ Select a TOP-R model and a port, and then select an external device. 
 

 

 
 

 

 

Settings Contents 

TOP-R Model Check the TOP-R display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP-R. 

Select “IA Corporation”. 

PLC Select an external device to connect to TOP-R. 
 

Model Interface Protocol 

ROBO CYLINDER 

(MODBUS –CON,RC Series) 

Computer Link Modbus 

 

 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP-R Communication setting 

The communication can be set in TOP Design Studio or TOP-R main menu. The communication should be set in the same way as 

that of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project property > TOP Settings ] → [ Project options > “HMI Setting Use” Check > Edit > Serial ] 

– Set the TOP communication interface in TOP-R Design Studio. 
 

 

 

 

 

Items TOP-R External device Remarks 

Signal Level 

(port) 

RS-232C 

(COM1/COM2)  
RS-232C Set Users 

Baud Rate 38400 Set Users 

Data Bit 8 Set Users 

Stop Bit 1 Set Users 

Parity Bit None Set Users 

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP-R and an external device. (COM3 supports only RS-485.) 

Baud Rate Select the serial communication speed between the TOP-R and an external device. 

Data Bit Select the serial communication data bit between the TOP-R and an external device. 

Stop Bit Select the serial communication stop bit between the TOP-R and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP-R and an external device. 
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 (2) Communication option setting 

■ [ Project> Project property > PLC setting > COM1 > “ROBO CYLINDER (MODBUS –CON, RC Series)”] 

– Set the options of the Computer Link communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Configure the communication interface between the TOP-R and an external device. Refer to “2. External 

device selection”. Protocol Configure the communication protocol between the TOP-R and an external device. 

TimeOut (ms) Set the time for the TOP-R to wait for a response from an external device. Set Users 

SendWait (ms) Set the waiting time between TOP-R’s receiving a response from an external device 

and sending the next command request. 
Set Users 

Slave equipment 

Address No 

Set Slave equipment address No. 
Set Users 

Protocol Mode Set Protocol Mode (RTU/ASCII). Set Users 
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3.2. Communication setting in TOP-R  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP-R screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP-R External device Remarks 

Signal Level 

(port) 

RS-232C 

(COM1/COM2) 
RS-232C Set Users 

Baud Rate 38400 Set Users 

Data Bit 8 Set Users 

Stop Bit 1 Set Users 

Parity Bit None Set Users 

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP-R and an external device. (COM3 supports only RS-485.) 

Baud Rate Select the serial communication speed between the TOP-R and an external device. 

Data Bit Select the serial communication data bit between the TOP-R and an external device. 

Stop Bit Select the serial communication stop bit between the TOP-R and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP-R and an external device. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

 

Items Settings Remarks 

Interface Configure the communication interface between the TOP-R and an external device. Refer to “2. External 

device selection”. Protocol Configure the communication protocol between the TOP-R and an external device. 

TimeOut (ms) Set the time for the TOP-R to wait for a response from an external device. Set Users 

SendWait (ms) Set the waiting time between TOP-R’s receiving a response from an external device 

and sending the next command request. 
Set Users 

Slave equipment 

Address No 

Set Slave equipment address No. 
Set Users 

Protocol Mode Set Protocol Mode (RTU/ASCII). Set Users 
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP-R and an external device. 

- Touch the top of the TOP-R screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [ Control Panel> PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP-R, and external device setting status. (Reference: Communication diagnostics 

sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP-R Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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3. TOP-R Communication setting 

The communication can be set in TOP Design Studio or TOP-R main menu. The communication should be set in the same way as 

that of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [ Project > Project property > TOP Settings ] → [ Project options > “HMI Setting Use” Check > Edit > Serial ] 

– Set the TOP communication interface in TOP-R Design Studio. 
 

 
 

 
 

Items TOP-R External device Remarks 

Signal Level (port) RS-232C RS-232C  

Baud Rate 38400  

Data Bit 8  

Stop Bit 1  

Parity Bit None  

* The above settings are examples recommended by the company. 

 

Items Description 

Signal Level Select the serial communication method between the TOP-R and an external device.  

Baud Rate Select the serial communication speed between the TOP-R and an external device. 

Data Bit Select the serial communication data bit between the TOP-R and an external device. 

Stop Bit Select the serial communication stop bit between the TOP-R and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP-R and an external device. 
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(2) Communication option setting 

■ [ Project> Project property > PLC setting > COM1 > “ROBO CYLINDER (MODBUS –CON, RC Series)”] 

– Set the options of the Computer Link communication driver in TOP Design Studio. 

 

 

Items Settings Remarks 

Interface Configure the communication interface between the TOP-R and an external device. Refer to “2. External 

device selection”. Protocol Configure the communication protocol between the TOP-R and an external device. 

TimeOut (ms) Set the time for the TOP-R to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP-R’s receiving a response from an external device 

and sending the next command request. 
 

Slave equipment 

Address No 

Set Slave equipment address No. 
 

Protocol Mode Set Protocol Mode (RTU/ASCII).  
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3.2. Communication setting in TOP-R  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP-R screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

   

(1) Communication interface setting 

■ [ Main screen > Control panel > Serial ] 
 

 

Items TOP-R External device Remarks 

Signal Level (port) RS-485/RS-422 RS-485/RS-422  

Baud Rate 38400  

Data Bit 8  

Stop Bit 1  

Parity Bit None  

* The above settings are setting examples recommended by the company. 
 

Items Description 

Signal Level Select the serial communication method between the TOP-R and an external device.  

Baud Rate Select the serial communication speed between the TOP-R and an external device. 

Data Bit Select the serial communication data bit between the TOP-R and an external device. 

Stop Bit Select the serial communication stop bit between the TOP-R and an external device. 

Parity Bit Select the serial communication parity bit check method between the TOP-R and an external device. 
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 (2) Communication option setting 

■ [ Main screen > Control panel > PLC ] 
 

 

 

Items Settings Remarks 

Interface Configure the communication interface between the TOP-R and an external device. Refer to “2. External 

device selection”. Protocol Configure the communication protocol between the TOP-R and an external device. 

TimeOut (ms) Set the time for the TOP-R to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP-R’s receiving a response from an external device 

and sending the next command request. 
 

Slave equipment 

Address No 

Set Slave equipment address No. 
 

Protocol Mode Set Protocol Mode (RTU/ASCII).  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP-R and an external device. 

- Touch the top of the TOP-R screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [ Control Panel> PLC ]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP-R, and external device setting status. (Reference: Communication diagnostics 

sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP-R Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Serial Parameter Transmission 

Speed 
OK NG 

Data Bit OK NG 

Stop Bit OK NG 

Parity Bit OK NG 

Check address range  

OK NG 

6. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

 

Configure the communication setting of the external device by referring to its user manual. 

  



 

 External device connection manual for TOP Design Studio 15 / 23 

5. Cable table 

This chapter introduces a cable diagram for normal communication between the TOP-R and the corresponding device. 

(The cable diagram described in this section may differ from the recommendations of “IAI Corporation - IA MODBUS”) 

 

5.1. Cable table 1 

■RS232C 

TOP COM Port (9 pin) 

TOP COM 

Cable connection 

“PLC” 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 
Signal name 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

CD 1   

RD 2 SD 

SD 3 RD 

  DTR 

SG 5 SG 

DSR 6 DSR 

RTS 7 RTS 

CTS 8 CTS 

 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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5.2. Cable table 2 

■ RS422/485 
 

TOP COM Port (9 pin) - RS422 

TOP COM 

Cable connection 

“PLC” 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 
Signal name 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  SDA 

 2 SDB 

 3 RDA 

RDB 4 RDB 

SG 5 SG 

SDA 6  

 7  

 8  

SDB 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 

TOP COM Port (9 pin) - RS485 

TOP COM 

Cable connection 

“PLC” 

Pin 

arrangement*Note 1) 

Signal 

name 

Pin 

number 
Signal name 

 

Based on 

communication 

cable connector 

front, 

D-SUB 9 Pin male 

(male, convex) 

RDA 1  + 

 2 – 

 3 SG 

RDB 4  

SG 5  

SDA 6  

 7  

 8  

SDB 9  

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 

 
 

TOP COM 

Cable connection 

External 

device 

Pin arrangement 
Signal 

name 
Signal name 

 

╋  + 

— - 

SG SG 

 

 

 

 

 

 

 

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector. 
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6. Support Address 

The devices available in TOP-R are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP-R series supports the 

maximum address range used by the external device series. Please refer to each CPU module user manual and be 

careful not to deviate from the address range supported by the device you want to use. 

 

Name Description Bit Address Word Address R/W Size 

ALA0 Alarm detail code ALA0.00 ~ 

ALA0.15 
ALA0 Read 16bit 

ALA1 Alarm address ALA1.00 ~ 

ALA1.15 
ALA1 Read 16bit 

ALC0 Alarm code ALC0.00 ~ 

ALC0.15 
ALC0 Read 16bit 

ALT0 Alarm occurrence time ALT0.00 ~ 

ALT0.31 
ALT0 Read 32bit 

TLMC Total moving count 

(PCON-CA/CFA, ACON-CA/CB, 

 SCON-CA/CAL/CB and ERC3 only) 

TLMC.00 ~ 

TLMC.31 
TLMC Read 32bit 

ODOM Total moving distance 

(PCON-CA/CFA, ACON-CA/CB, 

 SCON-CA/CAL/CB and ERC3 only) 

ODOM.00 ~ 

ODOM.31 
ODOM Read 32bit 

TIMN0 Present time 

(SCON-CA/CAL/CB only) 

TIMN0.00 

~TIMN0.31 
TIMN Read 32bit 

TIMN1 Present time (PCON-CA/CFA, 

ACON-CA/CB only) 

TIMN1.00 

~TIMN1.31 
TIMN Read 32bit 

TFAN0 Total FAN driving time 

(SCON-CA/CAL/CB only) 

TFAN0.00 ~ 

TFAN0.31 
TFAN0 Read 32bit 

TFAN1 Total FAN driving time 

(PCON-CFA only) 

TFAN1.00 ~ 

TFAN1.31 
TFAN1 Read 32bit 

PNOW Current position monitor PNOW.00 ~ 

PNOW.31 
PNOW Read 32bit 

ALMC Present alarm code query ALMC.00 ~ 

ALMC.15 
ALMC Read 16bit 

DIPM Input port query DIPM.00 ~ 

DIPM.15 
DIPM Read 16bit 

DOPM Output port monitor query DOPM.00 ~ 

DOPM.15 
DOPM Read 16bit 

DSS1 Device status query 1 DSS1.00 ~ 

DSS1.15 
DSS1 Read 16bit 
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Name Description Bit Address Word Address R/W Size 

[DEC]<- Bit position 

 

[1] Emergency stop 

[2] Safety speed enabled/disabled 

[3] Controller ready 

[4] Servo ON/OFF 

[5] Missed work part in push-motion operation 

[6] Major failure 

[7] Minor failure 

[8] Absolute error 

[9] Brake 

[10] Pause 

[11] Home return completion 

[12] Position complete 

[13] Load cell calibration complete 

[14] Load cell calibration status  

DSS2 Device status query 2 DSS2.00 ~ 

DSS2.15 
DSS2 Read 16bit 

[DEC]<- Bit position 

 

[1] Enable 

[2] Load output judgment  

(check-range load current threshold) 

[3] Torque level (load current threshold) 

[4] Teaching mode (normal/teaching) 

[5] Position data load (normal/complete) 

[6] Jog+ (normal/command active) 

[7] Jog- (normal/command active) 

[8] Position complete 7 

[9] Position complete 6 

[10] Position complete 5 

[11] Position complete 4 

[12] Position complete 3 

[13] Position complete 2 

[14] Position complete 1 

[15] Position complete 0 

DSSE Expansion device status query DSSE.00 ~ 

DSSE.15 

DSSE Read 16bit 

[DEC]<- Bit position 

 

[1] Emergency stop (emergency stop input port) 

[2] Motor voltage low 

[3] Operation mode (AUTO/MANU) 

[4] Home return 

[5] Push-motion operation in progress 

[6] Excitation detection 

[7] PIO/Modbus switching 

[8] Position-data write completion status 

[9] Moving 
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Name Description Bit Address Word Address R/W Size 

STAT System status query STAT.00 ~ 

STAT.31 

STAT Read 32bit 

VNOW Current speed monitor VNOW.00 ~ 

VNOW.31 

VNOW Read 32bit 

CNOW Current ampere monitor CNOW.00 ~ 

CNOW.31 

CNOW Read 32bit 

DEVI Deviation monitor DEVI.00 ~ DEVI.31 DEVI Read 32bit 

STIM System timer query STIM.00 ~ 

STIM.31 

STIM Read 32bit 

SIPM Special input port query SIPM.00 ~ 

SIPM.15 

SIPM Read 16bit 

[DEC]<- Bit position 

 

[1] Command pulse NP 

[2] Command pulse PP 

[3] Port Switch 

[3] Mode switch 

[4] Enable Switch 

[5] Home check sensor 

[6] Overtravel sensor 

[7] Creep sensor 

[8] Limit sensor 

  

ZONS Zone status query ZONS.00 ~ 

ZONS.15 
ZONS Read 16bit 

[DEC]<- Bit position 

 

[1] LS2 (PIO pattern solenoid valve mode [3-point 

type] 

[2] LS1 (PIO pattern solenoid valve mode [3-point 

type] 

[3] LS0 (PIO pattern solenoid valve mode [3-point 

type] 

[4] Position zone 

[5] Zone 2 

[6] Zone 1 

POSS Positioning complete  

position No. status query 

Exected program No. register 

(Servo Press) 

POSS.00 ~ 

POSS.15 
POSS Read 16bit 

SSSE Expansion system status register SSSE.00 ~ 

SSSE.15 
SSSE Read 16bit 

[DEC]<- Bit position 

 

[1] Cold start level alarm occurred/not occurred 

[2] RTC (calendar) function used/not used 

(ERC3, PCON/ACON-CA/CFA/CB type only) 

FBFC Force feedback data monitor FBFC.00 ~ 

FBFC.31 
FBFC Read 32bit 

OLLV Overload level monitor OLLV.00 ~ 

OLLV.15 
OLLV Read 16bit 
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Name Description Bit Address Word Address R/W Size 

ALMP0 Press program alarm code ALMP0.00 ~ 

ALMP0.15 
ALMP0 Read 16bit 

ALMP1 Alarm generated press  

program No. 

ALMP1.00 ~ 

ALMP1.15 
ALMP1 Read 16bit 

PPST Pres program status register PPST.00 ~ 

PPST.15 
PPST Read 16bit 

[DEC]<- Bit position 

 

[1] Waiting 

[2] While in returning operation 

[3] While in depression operation 

[4] Pressurize during the stop 

[5] While in pressurizing operation 

[6] While in probing operation 

[7] While in approaching the operation 

[8] Program home return during the movement 

[9] Program alarm 

[10] Program finished in normal condition 

[11] While in excecuting program 

[12] Program home position 

 

 

 

 

 

 

  
PPJD Press program status judgements 

register 

PPJD.00 ~ 

PPJD.15 
PPJD Read 16bit 

[DEC]<- Bit position 

 

[1] Load judgement NG 

[2] Load judgement OK 

[3] Position (distance) judgement NG 

[4] Position (distance) judgement OK 

[5] Total judgement NG 

[6] Total judgement OK 

SFTY Safety speed command 
SFTY - 

Read/

Write 
1bit 

SON Servo ON command 
SON - 

Read/

Write 
1bit 

ALRS Alarm reset command 
ALRS - 

Read/

Write 
1bit 

BKRL Brake forced-release 

command 
BKRL - 

Read/

Write 
1bit 

STP Pause command 
STP - 

Read/

Write 
1bit 

HOME Home return command 
HOME - 

Read/

Write 
1bit 

CSTR Positioning start command 
CSTR - 

Read/

Write 
1bit 

JISL Jog/inch switching 
JISL - 

Read/

Write 
1bit 

MOD Teaching mode command 
MOD - 

Read/

Write 
1bit 
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Name Description Bit Address Word Address R/W Size 

TEAC Position data load command 
TEAC - 

Read/

Write 
1bit 

JOG+ Jog+ command 
JOG+ - 

Read/

Write 
1bit 

JOG- Jog- command 
JOG- - 

Read/

Write 
1bit 

ST7 Start position 7 

(solenoid valve mode) 
ST7 - 

Read/

Write 
1bit 

ST6 Start position 6 

(solenoid valve mode) 
ST6 - 

Read/

Write 
1bit 

ST5 Start position 5 

(solenoid valve mode) 
ST5 - 

Read/

Write 
1bit 

ST4 Start position 4 

(solenoid valve mode) 
ST4 - 

Read/

Write 
1bit 

ST3 Start position 3 

(solenoid valve mode) 
ST3 - 

Read/

Write 
1bit 

ST2 Start position 2 

(solenoid valve mode) 
ST2 - 

Read/

Write 
1bit 

ST1 Start position 1 

(solenoid valve mode) 
ST1 - 

Read/

Write 
1bit 

ST0 Start position 0 

(solenoid valve mode) 
ST0 - 

Read/

Write 
1bit 

CLBR Load cell calibration 

command 
CLBR - 

Read/

Write 
1bit 

PMSL PIO/Modbus switching 

specification 
PMSL - 

Read/

Write 
1bit 

STOP Deceleration stop 
STOP - 

Read/

Write 
1bit 

ENMV Axis operation permission 
ENMV - 

Read/

Write 
1bit 

PHOM Program home return 

 movement 
PHOM - 

Read/

Write 
1bit 

SSTP Search stop 
SSTP - 

Read/

Write 
1bit 

FPST Program compulsoly finish 
FPST - 

Read/

Write 
1bit 

PSTR Program start 
PSTR - 

Read/

Write 
1bit 

DRG1 Device control register 1 DRG1.00 ~ 

DRG1.15 
DRG1 

Read/

Write 
16bit 

[DEC]<- Bit position  

 

 [0~2]Cannot be used 

 [3] Positioning start command 

[4] Home return command 

 [5] Pause command 

 [6] Cannot be used 

 [7] Brake forced-release command 

 [8] Alarm reset command 

 [9~11] Cannot be used 

[12] Servo ON command 

 [13] Cannot be used 

[14] Safety speed command 

[15]EMG operation specification  
DRG2 Device control register 2 DRG2.00 ~ DRG2 Read/ 16bit 
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Name Description Bit Address Word Address R/W Size 

DRG2.15 Write 

[DEC]<- Bit position  

 

[0~7]Start Posistion 0~7 

[8] Jog- command 

[9] Jog+ command 

 [10]Position data load command 

 [11]Teaching mode command 

 [12~13]Cannot be used 

 [14]Jog/inch switching 0:Jog 1:Inching 

 [15]Cannot be used  
POSR0 Position number command 

 register 

/Program number command  

register 

POSR0.00 ~ 

POSR.15 
POSR0 

Read/

Write 
16bit 

POSR1 Position movement command 

register 

POSR1.00 ~ 

POSR1.15 
POSR1 

Read

/Write 
16bit 

PCMD Target position 

specification register 

PCMD0.00 ~ 

PCMD1.15 
PCMD 

Read

/Write 
32bit 

INP Positioning band 

specification register 
INP0.00 ~ INP1.15 INP 

Read/

Write 
32bit 

VCMD Speed specification register VCMD0.00 ~ 

VCMD1.15 
VCMD 

Read/

Write 
32bit 

ACMD Acceleration/deceleration 

specification register 

ACMD.00 ~ 

ACMD.15 
ACMD 

Read/

Write 
16bit 

PPOW Push-current limiting value 

specification register 

PPOW.00 ~ 

PPOW.15 
PPOW 

Read/

Write 
16bit 

CTLF Control flag specification 

register 

CTLF.00 ~ 

CTLF.15 
CTLF 

Read/

Write 
16bit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Position Data Description Reading (With RC Series controllers) 
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Name Description Bit Address Word Address R/W Size 

PDDR Position Data Description 

Reading 

(With RC Series controllers) 

PDDR:000:0.00 

~PDDR:767:F.00 

(DEC:HEX.DEC) 

PDDR Read 16bit/32bit 

Address Format 

Name -> PDDR 

Position Number ->  :000 ~ :767  

Offset from Top Address ->  :0 ~ :F  

bit Position Number -> .00 

 

Offset from Top Address 

[0~1]PCMD - Target position(32bit) 

[2~3]INP - Positioning band(32bit) 

[4~5]VCMD - Speed command(32bit) 

[6~7]ZNMP - Individual zone boundary + (32bit) 

[8~9]ZNLP - Individual zone boundary - (32bit) 

[A]ACMD - Acceleration command(16bit) 

[B]DCMD - Deceleration command(16bit) 

[C]PPOW - Push-current limiting value(16bit) 

[D]LPOW - Load current threshold(16bit) 

[E]CTLF - Control flag specification(16bit) 

[F]Cannot be used (16bit) 

※ For PDDR 32bit, you must check wordswap. 

 

Name 
Bit Address Word Address R/W 

D(Data register) D0000.15-DFFFF.15 D0000-DFFFF Read/Write 

S(Status register) S0000-SFFFF S0000-SFFF0 Read/Write 

 


